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Introduction
This booklet explains how to view the images you took with the 
PENTAX Optio 33LF on your PC. Keep this manual in a safe place.

Regarding copyrights
Images taken using the Optio 33LF that are for anything other than personal 
enjoyment cannot be used without permission according to the rights as 
specified in the Copyright Act. Please take care, as there are even cases 
where limitations are placed on taking pictures even for personal enjoyment 
during demonstrations, industrial enterprise or as items for display. Images 
taken with the purpose of obtaining copyrights also cannot be used outside 
the scope of use of the copyright as laid out in the Copyright Act, and care 
should be taken here also.

Regarding trademarks
• The SD logo  is a trademark.
• PENTAX is a trademark of PENTAX Corporation.
• Optio is a trademark of PENTAX Corporation.
• All other brands or product names are trademarks of registered trademarks 

of their respective companies.
• Apple, the Apple logo, AppleScript, the Apple Store, Mac, the Mac logo, 

Mac OS, Macintosh, and QuickTime are trademarks of Apple Computer, 
Inc., registered in the U.S. and other countries.

• This product supports PRINT Image Matching II.
When used in combination, PRINT Image Matching II enabled digital still 
cameras, printers and software help photographers to produce images 
more faithful to their intentions.
Copyright 2001 Seiko Epson Corporation. All Rights Reserved.
PRINT Image Matching is a trademark of Seiko Epson Corporation.

• Symbols used in this manual have the following meanings:

The PC screenshots in this booklet may differ from your PC, depending on 
your model.

Gives page numbers explaining related operations.

Gives information that is useful to know.

Gives cautions and notes about the operation.
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Your Digital Camera: From Image Capture 
to Photo Prints

Connect your camera to a TV with 
an AV cable to enjoy your pictures 
on the screen.

Optio 33 LF Operating Manual 
(P.82)

Is your computer…
• equipped with a standard USB interface?
• using Windows Me / 2000 / XP as your OS?

Mac OS 9.0 or later?

Connect your camera 
and computer with a 
USB cable, and copy 
the camera images.

Have prints made from your 
card images at a photo shop.

Transfer your images using th
built-in card slot + PC card 
adaptor or a card reader.

• Set DPOF settings on your 
camera, and have prints 
made at your photo shop. 

 Optio 33 LF Operating 
Manual (P.83)

• Select images to print.

Here are some ways to use the images 
captured with your digital camera.

View on TV

Have prints made

Is your computer…
• using Windows 95 / 98 SE / NT?

Mac OS 8.6, or earlier?

• Remove the card from the 
camera. When transferring 
images on the card to a PC 
with another device, make 
sure to review the user manu
accompanying that device. 



• See the operating manual of your 
email software for details on how to 
make attachments to emails.

• See the operating manual of the 
software you are using for details on 
how to use images on your 
homepage.

Print images from your 
computer to your printer.
Some printers can print 
directly from cards.
• For details, see the 

operating manual of the 
printer you are using.

Images sent to the computer can be 
saved onto a CD-R or other media.

Use your printer

ACDSee for PENTAX

Use your e-mail software to attach images to e-mails, or 
use them on your homepage.

Internet

* These operations also can be performed using 
commercially available image editing software. See 
the instructions provided with the software for more 
details.

 P.19-35
• View Images
• Edit Images
• Save processed images
• E-mail Images
• Manipulate images
• Print images
3
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Viewing Digital Camera Images on a 
Windows PC

You can use the provided USB cable (I-USB2) or a card reader to 
transfer your digital camera’s images to the PC, and you can edit and 
print your images using the image viewing software. Here, the method 
for viewing images with the provided software (S-SW12) is explained.

The following software is included in the CD-ROM (S-SW12) provided.
• Image viewing / editing software (ACDSee for PENTAX)
• QuickTime

USB connection
• OS: Windows Me / 2000

Windows XP Home Edition / Professional
• USB mass storage class (USB 1.1)
• Installation of the driver is not necessary.

Application Software
1. ACDSee for PENTAX

(7 languages: Japanese, English, German, French, Spanish, 
Italian, Chinese)
• OS: Windows 98 / Me / NT (latest version) / 

2000 
Windows XP Home Edition / Professional

• CPU: Pentium or higher recommended
• Memory: 64MB minimum
• Hard Disk space: 40MB minimum
• Display adapter capable of displaying a minimum of 256 colors
• Internet Explorer 4.0.2 or later
• Some formats may require viewing with QuickTime 6.0 or 

later and DirectX 8.0 or later.
• To install ACDSee, Windows Installer Service Version 2.0 

may be required.

Software Provided

System Requirements



2. QuickTime
(6 languages: Japanese, English, German, French, Spanish, 
Italian)
• OS: Windows 98 / NT / Me / 2000  

Windows XP Home Edition / Professional
• CPU: Pentium or higher recommended
• Memory: 128MB minimum

Movie Pictures
• AVI (Motion JPEG) compliant
• You may play movie pictures taken using the provided 

software [ACDSee for PENTAX] (QuickTime required).

We recommend using the AC Adapter D-AC5 when connecting your 
camera to your PC. Your image data could be corrupted if the 
batteries in your camera run out during image transfer.
5
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This section describes the procedures for installing ACDSee for 
PENTAX which lets you view and edit recorded images on your 
computer.

1 Turn your computer on.
2 Insert the CD-ROM (S-SW12) into your CD-ROM drive.
3 Double-click [My Computer] on the desktop.
4 Double-click the [CD-ROM drive (S-SW12)] icon.
5 Double-click the [Setup.exe] icon.
6 Click your applicable 

language.
You can choose the language from 
the following: English, French, 
German, Spanish, Italian, Japanese 
and Chinese.

7 Click [ACDSee™].

Installing the image processing software 
(ACDSee for PENTAX)

When multiple accounts have been setup in Windows 2000 or 
Windows XP, login by the authority of the administrator before 
installing the software.



The Setup screen will appear.
Follow the on-screen guidance and 
enter the registration information.
Reboot your PC after installation is 
complete.

• Click [Install QuickTime] to first 
install QuickTime 6.0 when a 
message such as the one shown 
on the right is displayed.

The panoramic image software [ACD photostitcher], the image 
layout and printing software [FotoSlate], and the image editing 
software [FotoCanvas] also are installed when you install ACDSee 
for PENTAX.
7
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An explanation of how to display / copy images using ACDSee for 
PENTAX is shown below.

1 Turn your computer on.
2 Turn your camera off and connect it to the PC with the 

USB cable.
When copying or displaying images recorded on a SD Memory 
Card / MultiMediaCard, please check that the card is inserted in 
the camera before connecting.
When copying or displaying images recorded in the internal 
memory, please check that any cards have been removed from the 
camera before connecting to your PC.

3 Turn your camera on.
The Device Detector screen is displayed automatically.
If the Device Detector screen is not displayed, display / copy the 
images following the steps in “When the Device Detector screen is 
not displayed.” on page 9.

4 Confirm that [Copy images to 
hard drive] and [Launch 
ACDSee] are checked, and 
click [Next].

Displaying and Copying Images on your PC



5 Confirm that [My Pictures] is 
selected for [Create folder in:] 
and click [Next].

The image is copied to the PC, and 
the ACDSee for PENTAX Browser 
starts.

When the Device Detector screen is not displayed.
4 Double-click the [ACDSee for 

PENTAX] icon on the desktop.

5 Double-click [My Computer].

6 Double-click [Removable 
Disk] (If the SD Memory Card / 
MultiMediaCard has a volume 
label name, then select that 
name).
9
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7 Double-click the [DCIM] folder.

8 Double-click the [xxxPENTX] 
folder.
(xxx is a 3-digit number.)

9 Select the image you wish to 
view from the Browser.

Double-click the image to enlarge 
(Viewer).

10 Select the image you wish to copy from the Browser or 
Viewer.

(Browser)

(Viewer)



11 Select [Copy To…] from the 
[Edit] menu.
The Copy Files screen is displayed.

12 Click [More>>] and select the 
target folder.

13 Click [OK].
The image is copied to the PC.
11
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1 Double-click the [Unplug or 
eject hardware] icon in the task 
bar recognized area.
The [Remove Hardware] screen will 
appear.

2 Confirm that [PENTAX USB 
DISK Device] is selected and 
click [Stop].
The [Stop Hardware Device] screen 
will appear.

3 Confirm that [PENTAX USB 
DISK Device] is selected and 
click [OK].
A message will appear.

4 Click [OK].

5 Turn off the camera and 
disconnect the USB cable from your camera and PC.

Disconnecting the Camera from your PC

Windows 2000 / Me

When the camera and PC are connected and the focus status lamp 
(green) on the camera is blinking, the PC is downloading image data 
from the camera. Disconnecting the camera at this time may damage 
the image data.
In the event that an error message is displayed in Step 4, confirm that 
the focus status lamp (green) is off and then disconnect the camera.



1 Double-click the [Safely 
Remove Hardware] icon in the 
task bar recognized area.

2 Click [PENTAX USB DISK 
Device] and click [Stop].

3 Click [PENTAX USB DISK 
Device] and click [OK].

4 When a message is displayed 
permitting removal, turn the 
camera off and disconnect the 
USB cable from your camera 
and PC.

Windows XP
13
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Viewing Digital Camera Images on a 
Macintosh

You can use the provided USB cable (I-USB2) or a card reader to 
transfer your digital camera’s images to the Macintosh, and you can 
edit and print your images using the image viewing software. Here, 
the method for viewing images with the provided software (S-SW12) 
is explained.

The following software is included in the CD-ROM (S-SW12) provided.
• Image viewing / editing software (ACDSee for PENTAX)

USB connection
• OS: Mac OS 9.0 or later
• USB mass storage class
• USB 1.1
• Installation of the driver is not necessary.

Application Software
ACDSee for PENTAX 
(6 languages: Japanese, English, German, French, Spanish, Italian)

• OS: Mac OS 8.6 or later (QuickTime 4.0 or later 
or CarbonLib latest version required)

• CPU: Power Macintosh 266MHz or higher
• Memory: 8MB minimum
• Hard Disk space: 6MB minimum

Movie Pictures
• AVI (Motion JPEG) compliant
• You may play movie pictures taken using the provided 

software [ACDSee for PENTAX] (QuickTime required).

Software Provided

System Requirements

We recommend using the AC Adapter D-AC5 when connecting your 
camera to your Macintosh. Your image data could be corrupted if 
your batteries run out during image transfer.



1 Turn your Macintosh on.
2 Insert the CD-ROM (S-SW12) in the CD-ROM drive.
3 Double-click the [CD-ROM (S-SW12)] icon.
4 Double-click the [Install ACDSee™] icon.

The [PENTAX Software Installer] screen will appear.
If the [Master Installer] icon appears, double-click the icon. The 
[PENTAX Software Installer] screen will appear.

5 Click your applicable 
language.
You can choose the language from 
the following: English, French, 
German, Spanish, Italian and 
Japanese.

6 Click [ACDSee™].
The setup screen will appear.
Follow the on-screen guidance to 
input registration information and 
install the software.
When installation is complete, 
reboot your Macintosh.

Installing the image processing software 
(ACDSee for PENTAX)

If the message [CarbonLib-xxxxx could not be found] is displayed 
during installation, you must add the function expansion file called 
[CarbonLib] to the function expansion folder in the system folder in 
order to install the provided software in Mac OS 8.6 - 9.2.
This error message appears when this function expansion file is not 
present or when an old version of the file is present.
The latest version of the CarbonLib is available on the Apple 
website. Download the file and then install it onto Mac OS.
Apple website: http://www.Apple.com
Contact Apple for detailed information on how to use CarbonLib.
15



16
1 Turn your Macintosh on.
2 Turn your camera off and connect it to the Macintosh 

with the USB cable.
When copying or displaying images recorded on a SD Memory 
Card / MultiMediaCard, please check that the card is inserted in 
the camera before connecting.
When copying or displaying images recorded in the internal 
memory, please check that any cards have been removed from the 
camera before connecting to your Macintosh.

3 Turn your camera on.
The camera is recognized as [untitled] ([NO_NAME] in 
OS X) on the desktop. The folder name can be 
changed.

4 Double-click the [ACDSee for PENTAX] folder on the 
desktop.

5 Double-click the [ACDSee for PENTAX] program icon.
An image list (Browser) is displayed.

Displaying and Copying Images on your 
Macintosh

Displaying images on your Macintosh



6 Open the camera folder.
The camera images are in the [untitled] (or volume label name if 
the SD Memory Card has one) → [DCIM] → [XXXPENTX] (XXX is 
a three-digit number) folder.
An image list of the camera is displayed.

7 Select the image to view from the image list.
Double-click the image you selected. A full-size image is displayed 
(Viewer).

See your Macintosh user’s manual for how to copy or move files. 
Please copy images to your Macintosh before editing them.

1 Drag [untitled] (or the volume label name on the SD 
Memory Card / MultiMediaCard) to your trash.

2 Turn off the camera and disconnect the USB cable from 
your camera and Macintosh.

If the SD Memory Card / MultiMediaCard has a volume label, the 
volume label name will be displayed instead of [untitled]. A new SD 
Memory Card / MultiMediaCard unformatted may show the 
manufacturer name or model number.

Copying images to your Macintosh

Disconnecting the Camera from your Macintosh
17



About ACDSee for PENTAX

[ACDSee for PENTAX] is a comprehensive software package that 
acquires, organizes, displays, processes, and shares digital camera 
images.
You can use the Browser (  p.20) to acquire digital camera images 
efficiently. You then can organize them in your favorite way and even 
display them as thumbnails.
You can use the Viewer (  p.27) to view a large version of a single image.

Further, when you install [ACDSee for PENTAX] which is on the 
provided CD-ROM (S-SW12) on a Windows PC, the panoramic 
image software [ACD photostitcher] (  p.29), the image layout 
software [FotoSlate], and the image editing software [FotoCanvas] 
also are installed at the same time. Use this software to enjoy an even 
higher degree of freedom in your image creation, editing and 
processing.

This manual provides explanations regarding the most basic 
[ACDSee for PENTAX] functions. Refer to the Help section in 
[ACDSee for PENTAX] for detailed information. For information on 
use with a Macintosh, also refer to the Help section.

1 Double-click the [ACDSee for PENTAX] icon on the desktop.
ACDSee for PENTAX will launch and the Browser will be displayed.

1 Double-click the [ACDSee for PENTAX] folder on the desktop.
2 Double-click the [ACDSee for PENTAX] program icon.

ACDSee for PENTAX will launch and the Browser will be displayed.

Select [Exit] from the [File] menu in the Browser or the Viewer.

Launching ACDSee for PENTAX
For Windows

For Macintosh

To exit ACDSee for PENTAX
19
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Viewing using the Browser

In [ACDSee for PENTAX], you can view images using either the 
Browser, which displays a list of images, or the Viewer, which 
displays one image at a time.
The Browser is displayed when you launch [ACDSee for PENTAX].

Here, explanations are provided regarding Browser configuration as 
well as names and functions within the Browser.

Menu bar
You can select and execute the various functions and settings of the 
ACDSee for PENTAX by choosing the menu items from the menu 
bar.

About the Browser

For Windows



Browser toolbar
Browser toolbar includes shortcut buttons for commonly used 
functions and tools. These buttons open dialog boxes or display 
further activity buttons.
You can customize the toolbar by turning the button labels on or off, 
adding or removing buttons, and changing the size of the buttons.

Navigation pane
Navigation pane displays a folder tree of the folders on your 
computer, extra drive, or peripheral device.
Navigation pane includes the Folders, Calendar, Categories, Photo 
Discs, and Albums tabs. You can select these tabs to display their 
contents in the File pane, or to organize your files and folders.

Preview pane
Preview pane displays the image selected in the File pane.

Status bar
Status bar displays information and properties for the selected 
folder, file or files.

File pane
File pane displays the contents of a folder selected in the Navigation 
pane as a list of files or as thumbnails.
You can sort your images by such criteria as file name, file extension, 
file size, file date, etc. 

File list toolbar
With these shortcut buttons, you can copy, move or delete items, 
select what file types or folders to display in the File pane, and sort 
your images.
It also includes the path box that describes the location of the folder 
of images currently displayed in the File pane.
You can customize the toolbar by turning the button labels on or off, 
adding or removing buttons, and changing the size of the buttons.

When these categories are not displayed, check ( ) the categories 
you want to display in the [View] menu.
21
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Menu bar
You can select and execute the various functions and settings of the 
ACDSee for PENTAX by choosing the menu items from the menu 
bar.

Browser toolbar
Browser toolbar includes shortcut buttons for commonly used 
functions and tools. These buttons open dialog boxes or display 
further activity buttons.

Navigation pane
Navigation pane displays a folder tree of the folders on your 
computer, extra drive, or peripheral device.

Preview pane
Preview pane displays the image selected in the File pane.

For Macintosh



File pane
File pane displays the contents of a folder selected in the Navigation 
pane as a list of files or as thumbnails.
You can sort your images by such criteria as file name, file size, file 
date, etc. 

You can select any of the following 6 methods to display lists of 
images in the Browser. 
Select [Mode] in the [View] menu and then select a display method 
from the submenu. You can choose from the following display 
methods.

Thumb+Details
Display image file thumbnails and file information in a list format. 
You can change the file information that is displayed. (  p.26)

Thumbnails
Display image file thumbnails.

Large Icons
Display large icons and file names.

Small Icons
Display small icons and file names.

List
Display small icons and file names in a list format.

Details
Display small icons and file information in a list format. 
You can change file information that is displayed. (  p.26)

Changing the Browser display method
23
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To view images stored in other folders, select a folder from the folder 
tree in the Browser Navigation pane or directly specify a folder in the 
path box.

Folders selected from the folder tree are designated as the current 
folder and images from that folder are displayed in the File pane.

To display a subfolder
 is displayed next to the folder icon of folders that contain 

subfolders. Click  to display the subfolders.  is displayed next to 
folders when subfolders are displayed. Click  to hide the subfolders.

You can view the contents of the folder one level above the current 
folder by clicking  in the Browser toolbar.
You can view the contents of the folder displayed prior to the current 
folder by clicking  in the Browser toolbar.
When you use  in the Browser toolbar to change the displayed 
folder, click  to return to the folder displayed after the current folder.

Select [Path Box] from the [View] menu to display the path box in the 
File pane. Directly enter in the path box the path of the folder 
containing images you want to view. Images in that folder are 
displayed in the File pane. 
Also, click  to the right of the path box to display a dropdown list 
containing a history of recently used folders. Select from the list a 
folder with images you want to view. Images from that folder are 
displayed in the File pane.

Viewing images in other folders

Selecting a different folder in the folder tree

Use the buttons on the Browser toolbar to select a 
different folder

Specifying a different folder using the Path box



You can change the order of image files displayed in the File pane.

Select [Sort] from the [View] menu and then select a sort key 
category from the submenu. 
You can choose from the following categories. 
Extension, Name, Size, Type, Date, Image Properties, Description

Select [Sort] from the [View] menu and then select [Forward] or 
[Reverse] from the submenu.

You also can sort image files and specify ascending / descending 
order using the numeric keypad on the keyboard.

Sorting image files

Selecting sort categories

Specifying ascending / descending order

• Clicking the right mouse button on the File pane background 
(empty area where images are not displayed as thumbnails or 
icons) will display the menu in the location of the cursor. You can 
use the same step to rearrange the menus.

• For Macintosh, you can choose from the following categories: File 
Name, File Size, Image Type, Date and Reverse Sort Order.

Sorting using the keyboard

0:Extension 4:Date
1:Name 5:Image Properties
2:Size 6:Description
3:Type +:Forward

-:Reverse

Enable Num Lock by pressing the Num Lock key on the keyboard 
when you want to sort using the numeric keypad.
25
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You can specify items displayed in the list as well as change the 
category order when the File pane is set to Details display.

Select [Columns] from the [View] menu and then select a display 
category from the submenu. 
You can choose from the following categories. 
Size, Type, Date, Image Properties, Description

Select another categories to remove checks when you do not want 
to display details.

You can adjust row width to match the amount of text displayed in 
the list. Align the cursor with the edge of the row header. Click on the 
edge when the cursor changes to a left-right arrow head and drag the 
edge to adjust the row width.

Setting detailed display categories

Settings display categories

Clicking the right mouse button on the file list row header (portion 
where name, size, and other categories are written) will display the 
menu. You can use the same step to set the display categories. 

Adjusting the width of display category rows

Double-clicking the left mouse button on the row header separator 
will automatically adjust the row width to match the length of the list 
text.



Viewing a large version of an image 
(Viewer)

Double-click on a single image file selected in the Browser to display 
a full-screen view of that image. When the file is a movie, the movie 
will replay.

Here, explanations are provided regarding Viewer configuration as 
well as names and functions within the Viewer.

Menu bar
You can select and execute the various functions and settings of the 
ACDSee for PENTAX by choosing the menu items from the menu 
bar.

About the Viewer
27
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Viewer toolbar
Viewer toolbar includes shortcut buttons for commonly used 
functions and tools such as the Zoom tools.
You can customize the toolbar by turning the button labels on or off, 
adding or removing buttons, and changing the size of the buttons.

Status bar
Status bar displays information and properties for the selected 
folder, file or files.

Viewer pane
Viewer pane displays your images one at a time in full resolution.

When the viewer is displayed, you can close the viewer and switch 
to the browser by performing any of the following.
• Click the  (close) button.
• Double-click on the viewer pane border. 
• Press the [Esc] key on the keyboard. 



Panorama Image Stitching with ACD 
photostitcher

With ACD photostitcher installed on a Windows PC, you can 
panorama stitch the images you took in Panorama Assist mode.
The folder and image names displayed on the explanatory 
screenshots will differ according to the setup of your PC.

1 Run ACDSee for PENTAX.
An image list is displayed.

2 Select the images for panorama stitching from the 
image list.
Press the [Ctrl] key on the keyboard while clicking on pictures to 
select multiple images.
After selecting the images, select [Extras] from the [Activities] 
menu, and select [ACD photostitcher] from the submenu.
The [ACD photostitcher] is not enabled if two or more images are 
not selected. The images must be the same size.

When multiple accounts have been setup in Windows 2000 or 
Windows XP, login by the authority of the administrator before using 
ACD photostitcher.

• A Windows PC is necessary for panorama stitching. (ACD 
photostitcher is not compatible with Macintosh.)

• Panorama stitching cannot be performed on images of varying 
save sizes.

Select images
29
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3 Correct the image positioning.
[ACD photostitcher] starts, and the selected images are displayed 
in panorama format.
Move the mouse pointer onto the image. It changes into a e symbol.
Hold down the left mouse button and drag the images to adjust the 
stitching position.
When the position is adjusted, click the [STITCH] button.

4 Select the stitching method.
You can choose the stitching method from [Big Plane] and [Cylinder]. 
Here, you will create a flat panorama. Click the [Big Plane] button.
A confirmation message is displayed. Click [OK].

2 Click the 
[STITCH] button.

1 Click and drag to 
adjust position

Click [Big Plane].

• Click [OK] and continue if a screen like 
the one shown left is displayed. 



5 Trim the image.
Move the mouse pointer onto an image. It changes into a  symbol. 
Hold down the left mouse button and drag the dotted lines to adjust 
the image trimming position.
When the position is adjusted, click the [Trimming] button.

6 Save the image.
After confirming your trimming, click the [Save] button to save the 
image. To cancel the trimming, click the [Cancel Trimming] button.
When you are done, close ACD photostitcher and ACDSee for 
PENTAX.

2 Click the [Trimming] 
button.

1 Trim the image.

Click the [Save] button.

 [Cancel Trimming] button
31
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Printing an image

You can print image files from the Browser or the Viewer.

You can print one or more images from the Browser.

1 Select one or more images.
To print several images, press the [Ctrl] key on the keyboard while 
clicking on pictures to select multiple images for printing.

2 Select [Print Images] from the [File] menu.
The Print dialog box is displayed.

3 Select or change the printing options.
4 Click [Print].

You can print the currently viewed image, or all images that reside in 
the same folder as the currently viewed image.

1 Select [Print Image] from the [File] menu to print the 
currently viewed image. 
or 
Select [Print All Images] to print all images in the same 
folder.
The Print dialog box is displayed.

2 Select or change the printing options.
3 Click [Print].

Printing from the Browser

Printing from the Viewer



You can insert the date into an image file 
and print it. Date insertion settings are 
done in the Print dialog box.

1 Select the [Caption] tab in the 
Print dialog box.

2 Check the [Print image original 
date] check box.

You can create and print contact sheets of your images. You can add 
captions to each image, page headers and footers, and control 
thumbnail size.

1 In the Browser, select a group of images.
Press the [Ctrl] key on the keyboard while clicking on pictures to 
select multiple images for printing. 

2 Select [Print Contact Sheet] from the [File] menu.
The Print Contact Sheet dialog box is displayed.

3 Select or change the printing options.
4 Click [OK].

For more information about creating and printing contact sheets, 
click the Help button in the Print Contact Sheet dialog box.

To insert date and print image

Creating and Printing contact sheets
33
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E-mailing your images from ACDSee for 
PENTAX

You can send images directly from the ACDSee for PENTAX without 
using an external e-mail application. (E-mail account setup is 
required. See the ACDSee for PENTAX Help section for details.)
Image files are converted to JPEG format then attached to an e-mail 
and sent. Images are compressed before transmission when the file 
size is large but no changes are made to the original image.

1 In the Browser, select an 
image or a group of images.
To select several images, press the 
[Ctrl] key on the keyboard while 
clicking on pictures to select multiple 
images. 

2 Select [Share] from the 
[Activities] menu, then select 
[E-mail]. 
The Send E-mail dialog box is displayed.

3 Input the required information.
4 Click [Send].

For more information about e-mailing your images, click the Help 
button in the Send E-mail dialog box.

E-mail function is not compatible with Macintosh.

An error message may be displayed and you may not be able to 
send mail if your mail server security is set to a high level.



About ACDInTouch

ACDInTouch uses the Internet to display the latest information about 
ACDSee™. You can access information related to special offers, 
free digital imaging resources, newsletters, subscriptions and more.

1 Select [ACDInTouch] from the [Help] menu.
The Connect to ACDInTouch dialog box is displayed.

2 Click [Connect Now].

ACDInTouch is a data exchange service. When you connect, 
information is sent to you so that you can read up-to-date information 
directly in the ACDInTouch pane. This information is relevant to your 
product, such as upgrades, add-ons and related software from ACD 
Systems that may also be of interest to you.

For information on ACD Systems’ Privacy Policy, visit Web site at:

www.ACDSYSTEMS.com/english/company/privacy.htm

To connect to ACDInTouch

About the ACDInTouch services
35



• Printed on recycled paper 
• Specifications and external dimensions are subject to change without notice.

57285 Copyright © PENTAX Corporation 2003
01-200310 Printed in Japan

PENTAX Corporation 2-36-9,Maeno-cho, Itabashi-ku, Tokyo 174-8639, JAPAN
(http://www.pentax.co.jp/)

PENTAX Europe GmbH (European Headquarters)
Julius-Vosseler-Strasse, 104, 22527 Hamburg, GERMANY
(HQ - http://www.pentaxeurope.com)
(Germany - http://www.pentax.de) 

PENTAX U.K. Limited PENTAX House, Heron Drive, Langley, Slough, Berks 
SL3 8PN, U.K.
(http://www.pentax.co.uk)

PENTAX France S.A.S. 12/14, rue Jean Poulmarch, 95106 Argenteuil Cedex, 
FRANCE

PENTAX Benelux B.V. (for Netherlands)
Spinveld 25, 4815 HR Breda, NETHERLANDS
(http://www.pentax.nl)
(for Belgium & Luxembourg)
Weiveldlaan 3-5, 1930 Zaventem, BELGIUM
(http://www.pentax.be) 

PENTAX (Schweiz) AG Widenholzstrasse 1 Postfach 367 8305 Dietlikon, 
SWITZERLAND (http://www.pentax.ch)

PENTAX Scandinavia AB P.O. Box 650, 75127 Uppsala, SWEDEN
(http://www.pentax.se) 

PENTAX U.S.A., Inc 600 12th Street, Suite 300
Golden, Colorado 80401, U.S.A.
(http://www.pentax.com) 

PENTAX Canada Inc. 3131 Universal Drive, Mississauga, Ontario L4X 2E5, 
CANADA
(http://www.pentaxcanada.ca) 


	Your Digital Camera: From Image Capture to Photo Prints
	Viewing Digital Camera Images on a Windows PC
	System Requirements
	Installing the image processing software (ACDSee for PENTAX)
	Displaying and Copying Images on your PC
	Disconnecting the Camera from your PC

	Viewing Digital Camera Images on a Macintosh
	System Requirements
	Installing the image processing software (ACDSee for PENTAX)
	Displaying and Copying Images on your Macintosh
	Disconnecting the Camera from your Macintosh

	About ACDSee for PENTAX
	Launching ACDSee for PENTAX

	Viewing using the Browser
	About the Browser
	Viewing images in other folders
	Sorting image files
	Setting detailed display categories

	Viewing a large version of an image (Viewer)
	About the Viewer

	Panorama Image Stitching with ACD photostitcher
	Printing an image
	Printing from the Browser
	Printing from the Viewer
	Creating and Printing contact sheets

	E�mailing your images from ACDSee for PENTAX
	About ACDInTouch



